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1 An Introduction to Geometry Nodes


Join our community on Discord

https://packt.link/weEskIn this book, you’ll learn how to work with Geometry Nodes. You will find basic and intermediate-level information about Geometry Nodes here. This book will help you learn various topics, such as distributing points, modifying meshes, creating meshes, and basic nodes.If you are learning any kind of Blender workflow, Geometry Nodes will surely be a handy tool to know about. They open up new possibilities for procedural modeling and animation.You’ll also get the chance to try your skills with fun exercises throughout this book; these include exercises such as making a procedural plant, a procedural landscape, and a procedural spiderweb generator.In this chapter, we’ll talk about the practicality of Geometry Nodes, why they might be useful for you, and some scenarios in which this tool will be helpful. We will also go over the different node inputs and outputs. Finally, at the end of this chapter, you will learn how to access the Geometry Nodes system.In this chapter, we will cover the following topics:


	Understanding the Geometry Nodes system

	In what situations are Geometry Nodes applicable?

	Understanding the Geometry Node editor

	The different node inputs and outputs

	And finally, how to access the Geometry Node editor





Technical requirements

In this book, we will use Blender version 4.2, which can be downloaded from this link:https://download.blender.org/release/Blender4.2/If you do not have certain nodes, then you might have an outdated version of Blender. While newer versions of Blender might work with this book, we cannot guarantee that everything will match the explanations we give. For the best experience, we recommend using Blender 4.2.



Understanding the Geometry Nodes system

The Geometry Node editor is a feature in Blender 3.0. Over a period of time, it has evolved into a very useful tool that every CG artist should know. Geometry Nodes is all about procedurally modeling your mesh which can help with big scenes where you need lots of objects to have variation. For example, if you are making a forest, every tree needs to have randomness; otherwise, the scene will look like a render. To add variation to trees, we can utilize Geometry Nodes. Previously, creators would use hair particles to scatter objects along a mesh. With Geometry Nodes, this is no longer needed. Geometry Nodes will help in scattering all objects just the way you want. There are lots of ways to scatter your objects. We will also go over the various nodes to randomize these instances. The idea of Geometry Nodes is to procedurally generate a complex mesh out of a basic and simple input.This is not the only thing that Geometry Nodes can do though, in the recent updates of Blender 4.0 and onwards, it’s possible to mathematically create physics simulations by using complex formulas like gravity, forces and others.Unlike the Material Nodes editor, which does not use a Modifier, the Geometry Node editor is a Modifier that can be applied from the Modifiers tab. This Modifier can be combined with other Modifiers like any other would. The Geometry Nodes Modifier consists of the following parts:


[image: Figure 1.1: The Geometry Nodes Modifier]Figure 1.1: The Geometry Nodes Modifier

Part 1 refers to how many times the node tree has been used. If the node tree is only being used by one object, this number will not be there.The button in part 2 allows you to select a node tree out of the different node trees that you made in your project.Part 3 allows you to link various attributes to this variable. For example, you can link weight paint values with this for a simple stone distribution solution. We’ll look at weight paint later in this book.The button in part 4 allows you to animate the value of part 5. This can also be done by pressing i on any value field.Lastly, part 5 defines the current value that is being inputted into the node tree. You can change this value by clicking on it or by holding down your mouse cursor while sliding.Behind this Modifier lies the Geometry Nodes system. It consists of various nodes to procedurally model your objects.



In what situations are Geometry Nodes applicable?

Many people think that Geometry Nodes is the new way to model in Blender, and for certain scenarios, this is true. But there are times when you’re better off using the normal modeling workflow.Geometry Nodes are usually used to procedurally generate multiple objects at once and to scatter objects around on a mesh. For example, scattering grass onto a field, generating roads procedurally, or generating multiple buildings at once.They can also be used to create mathematically based physics simulations like point simulations with forces like gravity.They are also generally not used to model complex organic structures with lots of features, for example, faces, human figures, clothes, or simulations.While it is certainly possible to model these objects via Geometry Nodes, it’s very impractical to do so because the amount of detail in these objects is near impossible to program mathematically using Geometry Nodes. It’s much more practical to model the structures via the normal modeling workflow in Blender.Now that we’ve got a better understanding of when Geometry Nodes are applicable, we’ll talk about everything you need to know about the Geometry Node editor.



Understanding the Geometry Node editor

The Geometry Nodes system makes use of the node tree design in Blender, similar to the Material Node editor. Much like the Material Node editor, the node system flows from left to right. Geometry Nodes can modify and create different types of geometry, such as the following:


	Meshes: A mesh is a structural build of a 3D model consisting of faces. 3D meshes make use of the three axis points, x, y, and z. It is made up of vertices, which make up edges, which, in turn, make up faces.

	Curves: A curve is a way to define paths in Blender; this can be used on multiple occasions. For example, if you want a camera to follow a specific path, this can be done with curves. These can also be modified, used, and created in the Geometry Node editor. Curves will be further explained in Chapter 8.

	Point clouds: A point cloud is a selection of scattered points around a mesh. These point clouds are only visible in the viewport and not in the render.

	Volumes: A volume is a semi-transparent effect that can also be experimented with in the Geometry Node editor. Volumes are usually used to create abstract effects in the Geometry Node editor but can also be used to create a foggy atmosphere in your scene.

	Instances: An instance is best explained as a copy of the original mesh. This can be used to copy multiple objects around a mesh, much like we used to do with hair particles. This is mostly used to scatter rocks or grass onto a base mesh.



It’s notable to mention that these are all the geometry types that Geometry Nodes can modify, but Geometry Nodes can do much more, for example, make changes to your UVmap, or make changes to your materials based on certain properties. All of these nodes will use the same connection type, a Geometry Node connection. This node connection is green. Let’s have a look at the input and output nodes of the Geometry Nodes system.


Exploring the standard Geometry Nodes blocks

The first node that this book will introduce you to is the Group Input node.


[image: Figure 1.2: Group Input node]Figure 1.2: Group Input node

The standard Geometry output of this node returns the base mesh of your object before any modifications have been made. This node is used to add variables to the Geometry Nodes Modifier so that you can have easy access to the most used variables. To create these variables, just slide a value into the gray unused node socket, and it will automatically occupy the node socket and a variable will appear in your Modifier, as seen on Figure 1.1 (Part 5).At the end of the node tree, you will use a Group Output node.


[image: Figure 1.3: Group Output node]Figure 1.3: Group Output node

This will define the end of the Modifier. Just like the Group Input node, the Group Output node has an unused node socket to output extra data to the Modifier. This can be used to define UV maps, for example.Whatever you plug into the Geometry node connection of this node will be displayed in your viewport and will be the output of your modifier.




The different node inputs and how to use them

Now that we've looked into the group input and group output nodes, let's go over the various node inputs and outputs.Let’s start by explaining the various input and output shapes in the Geometry Node editor.


Exploring different shapes

Let’s take a closer look at the input and output shapes in the Geometry Node editor.


The round node input/output

This is what a round input/output node connection looks like:


[image: Figure 1.4: The round input/output node connection]Figure 1.4: The round input/output node connection

This defines a single node value. For example, in geometry nodes, a single node connection can send through multiple values from other locations. With a round connection, this is not the case. This will likely result in the value being rounded to one value or returning an error value.



The diamond input/output node connection

This is what a diamond input/output node connection looks like:


[image: Figure 1.5: The diamond input/output node connection]Figure 1.5: The diamond input/output node connection

It accepts multivalue fields. This means that every vertex on our mesh will be calculated separately according to the node tree. This feature in Geometry Nodes is very fun to play around with because each point gets its own flow of calculation, which opens up a world of interesting possibilities. An example of this feature is adding noise displacement to your mesh; each vertex will get its own displacement because each vertex is being calculated separately thanks to the diamond input/output node connection.Now let’s look at what different colors of node connections mean in the Geometry Node editor.




Exploring different node connection colors

Here’s an in-depth look at the different colors in the Geometry Node editor.


Boolean node input/output

This node connection offers Boolean values:


[image: Figure 1.6: The Boolean input/output node connection]Figure 1.6: The Boolean input/output node connection

This node connection will define either an on or an off value; in other words, this is a value with either a 1 or a 0. As explained previously, this can either be a single value (circle shape) or multiple values (diamond shape).



Vector node input/output

This is a vector node connection:


[image: Figure 1.7: The vector input/output node connection]Figure 1.7: The vector input/output node connection

This node connection internally carries three values. X, Y and Z. These values can be separated with a Separate XYZ node. It can also be combined with a Combine XYZ node. The vector node is used to define positions, rotations, scales, and offsets. It can also be used to define UV maps in the material node editor.



Geometry input/output

This is a geometry node connection.


[image: Figure 1.8: The geometry input/output node connection]Figure 1.8: The geometry input/output node connection

This defines geometry and instances. When you slide an object from the outliner into the Geometry Node editor, you will see this connection to add this instance to your Geometry Nodes project. This is also the connection you will see when you generate a point cloud with the Distribute Points on Faces node. This node connection will also show up on both sides when you use any geometry-modifying node, such as Transform Instance node, Scale Instance node, and any primitive mesh node. All of these nodes will be explained in Chapter 2.



Integer input/output

This is the integer node connection.


[image: Figure 1.9: The integer input/output node connection]Figure 1.9: The integer input/output node connection

This defines or accepts any value that is an integer; some examples of integer values are 0, 1, 2, 3, and 4. These values are basically values without a decimal point. These are usually used to define indexes of certain things, for example, duplicate objects. This node connection can be found on nodes such as the ID node, Duplicate Elements node, and Index node.



Value input/output

This is the value node connection, also known as the factor node connection.


[image: Figure 1.10: The value input/output node connection]Figure 1.10: The value input/output node connection

This defines a plain value. The difference between this and an integer node connection is that the value node connection can contain decimal points. Some examples of nodes containing this node connection are the Noise Texture node and any Math node. This value can also make great use of multivalue fields by making use of the diamond symbol we previously discussed.



Color input/output

This is a color node connection where we can input and output different color containing data like images, noise patterns and other RGB format data.


[image: Figure 1.11: The color input/output node connection]Figure 1.11: The color input/output node connection

This node connection internally contains three values, an R channel (red), a G channel (green), and a B channel (blue), also known as the RGB channels. These can be separated into their respective RGB values using a Separate Color node. They can also be combined using a Combine Color node. Just like the examples explained in the Exploring different shapes section, this node connection can also make use of multivalue fields.



String input/output

This node connection defines any text value, from a string of characters to multiple paragraphs.


[image: Figure 1.12: The string input/output node connection]Figure 1.12: The string input/output node connection

This value will mainly be seen on nodes that are made to create or modify text, such as the String node, the String to Curves node, and the String Length node. This will be explained in depth later on in the book.



Material input/output

This node connection defines a material from the Material Node editor.


[image: Figure 1.13: The material input/output node connection]Figure 1.13: The material input/output node connection

It can be used to set the material of selected geometry in the node editor. This node basically refers to a material you’ve already made and one that is included in the project. Some nodes that make use of this node connection are the Material node, the Set Material node, and the Replace Material node.Let’s look into some special node connections for joining input and outputs.




Multi-connection inputs

Multi-Connection inputs allow you to connect multiple output connections into one input socket. This is generally used to join multiple outputs into one input.


[image: Figure 1.14: Geometry multi-connection input]Figure 1.14: Geometry multi-connection input

The node connection seen in Figure 1.14 is usually used to combine elements; for example, the input shown in the preceding figure is used to join geometry together, as seen in the Join Geometry node.


[image: Figure 1.15: String multi-connection input]Figure 1.15: String multi-connection input

The socket in Figure 1.15 is used to join strings together. It works in the same way as the geometry multi-connection input.




Exercise – accessing the Geometry Nodes system

Now, you’ll learn how to access the handy Geometry Nodes tool in Blender.Before beginning, make sure you’ve installed Blender 4.2, otherwise exercises may not work correctly.


	Firstly, let’s start by opening Blender.

	Then, you can head on to the Geometry Nodes tab in the top section of your screen. Now your journey begins.




[image: Figure 1.16: Blender startup screen]Figure 1.16: Blender startup screen

When you click on the Geometry Nodes tab at the top of your screen, you’ll see the following:


[image: Figure 1.17: Geometry Node editor tab with info overlayed]Figure 1.17: Geometry Node editor tab with info overlayed

This might look overwhelming at first sight, but don’t worry, this book will guide you through all the parts of this node editor.There are five parts you’ll need to know about on this screen:


	Spreadsheet: This is a separate window that allows you to see various bits of information about elements of your geometry, such as, for example, the properties of instances.

	Viewport: This is your main view in Blender. It allows you to see the project in 3D space.

	Outliner: This is a list of all the objects in your current scene. This makes it easy to create instances by sliding your object from the outliner right into the Geometry Node editor.

	Geometry Node editor: The Geometry Nodes editor is your main editing workspace for working with Geometry Node trees.

	Modifier Stack: This is a list of all of your Geometry Node workspaces linked to your selected object. The Modifier Stack will also show any additional modifiers you have applied to your object.



To start working on Geometry Nodes, it’s important to learn how to add a node tree to your projects. There are two ways to do this:


	One way to do this is to add a Geometry Nodes Modifier from the Modifiers tab in the Properties panel. Go ahead and press the button Add Modifier. Once you press that button, you’ll see this menu:




[image: Figure 1.18: Modifier Stack add button]Figure 1.18: Modifier Stack add button

After you’ve added the Modifier to the Modifier stack, you’ll need to press the New button on the Geometry Nodes modifier.


[image: Figure 1.19: Geometry Nodes modifier]Figure 1.19: Geometry Nodes modifier

You’ve now successfully created a new Geometry Nodes project!


	The other way to do this (and the quicker way since we’re already in the Geometry Nodes workspace) is to just click the New button in the Geometry Node editor. This will automatically add a new Geometry Nodes Modifier along with a Group Input and a Group Output node. The following figure shows the New button you’ll find at the top of the Geometry Nodes workspace to add a new node tree, along with all the functions of the button.




[image: Figure 1.20: Node group selection box]Figure 1.20: Node group selection box

And with that, we have come to the end of this chapter, congratulations! You now know the basics of the Geometry Node editor.



Summary

We started this chapter by understanding the Geometry Node connection and its applicability. We also looked at some of the different types of geometry that this node can modify and create. We’ve also covered the various node inputs and outputs present in the Geometry Node editor. This includes the vector, boolean, color, integer, value, string, material, and geometry inputs, along with the different shapes of nodes. We have explained how to access the Geometry Node editor in various ways, how the node system works, how it flows, and everything there is to know about this new system in Blender. Having read this chapter, you will now understand how this Geometry Node system works and what kinds of node connections are available in the Geometry Node editor. In the next chapter, we’ll go over the nodes you’ll be needing the most in your basic projects.






2 Understanding the Functionality of Basic Nodes


Join our community on Discord

https://packt.link/weEskIn the last chapter, you learned how the Geometry Nodes system works; in this chapter, we will be explaining the beginner building blocks, or nodes of the Geometry Nodes system. To get started, we’ll introduce you to the basic nodes that you will be using throughout this book. These are the nodes that you will use in most of your projects to perform basic commands, such as combining mesh, converting mesh, instancing points on your mesh, and more. We will also explain what every input, output, and value means with visual examples.In this chapter, we will cover the following topics:


	What are the basic nodes?

	Exploring Mesh nodes

	Understanding Points Manipulation nodes

	Instance nodes

	Converter nodes





What are the basic nodes?

The basic nodes are the nodes that you will use the most in your Geometry Nodes projects, not only in this book but also when you will start creating Geometry Nodes projects on your own. These nodes perform the basic operations that you will need regularly, such as the Subdivision Surface node, the Join Geometry node, the Extrude Mesh node, and many more nodes that you will need most of the time.



Exploring mesh nodes

Let’s start by explaining the nodes you’ll need the most – the nodes to manipulate mesh. These are used to modify the mesh you are working with. In this section, we will go over the most basic ones you might have to use with any Geometry Nodes project.


The Subdivision Surface node

We are all familiar with the Subdivision Surface modifier. In the Geometry Node editor, there’s a node for that.


[image: Figure 2.1: Subdivision Surface node]Figure 2.1: Subdivision Surface node

To easily explain this node, we will be comparing it to the modifier. Under the Subdivision Surface node, the input node called Mesh refers to the mesh you give the node to process. The Level integer value refers to the iterations of subdivision, just as the modifier offers. The next values you’ll see on the node aren’t values we see on the modifier. These are Creasing Values. These define how much the mesh should be affected by the Subdivision Surface modifier. As you can see by the diamond node connection shape, the node has a multivalued field. That means that this node can process multiple values of creasing at different points.Now, let’s look at different creasing examples.


[image: Figure 2.2: Different creasing examples]Figure 2.2: Different creasing examples

As you can see in Figure 2.2, there are two types of creasing values.


	Edge Creasing defines how much each edge is impacted by the Subdivision Surface modifier. 0 means 100% impact, and 1 means 0% impact.

	Vertex Creasing works in the same way, except that instead of the edges being impacted, you’re now impacting each vertex, respectively.



Let’s look at the Join Geometry node next.



The Join Geometry node

Next, we’ll explain the usage of the Join Geometry node.


[image: Figure 2.3: Join Geometry Node]Figure 2.3: Join Geometry Node

As explained in Chapter 1, this node makes use of a multi-connection mesh input. This means, you can connect multiple node connections into this socket. The Geometry output node connection contains all the objects you’ve joined into one object.The Join Geometry node is best exhplained as the Join function in the Object Context Menu found when right clicking the Viewport.


[image: Figure 2.4: Object Context Menu]Figure 2.4: Object Context Menu

You can see Object Context Menu in Figure 2.4.



The Set Shade Smooth node

The Set Shade Smooth node has a lot of resemblance to the Shade Smooth function in Object Context Menu.


[image: Figure 2.5: The Set Shade Smooth node]Figure 2.5: The Set Shade Smooth node

The difference between this node and the function inside of Blender is that this has a Selection Boolean input. This means that by using the Selection input, we can selectively choose what parts of our inputted mesh can be shaded smooth and which can be shaded flat. The output value named Geometry outputs the mesh that has been shaded according to your selection inputs.There’s also an option up top which will define if you want your faces to be smoothed based on edges or faces. Edge smoothing will only smooth a face if all 4 edges are selected via the selection input.



The Extrude Mesh node

The following screenshot shows the Extrude Mesh node.


[image: Figure 2.6: The Extrude Mesh node]Figure 2.6: The Extrude Mesh node

This can be compared to the Extrude function in Edit Mode (Edit Mode can be accessed by pressing Tab in the viewport). This node accepts the base mesh as an input, along with a selection Boolean value of the mesh you want to extrude. If no value is given, it will select all the mesh to be extruded. The Offset value defines the offset that the extruded faces will use. This value is a vector value and can be controlled using values of the same purple socket. Offset Scale defines how much the faces will be extruded. The Offset Vector defines the coordinates of each of the extruded vertices by making use of a multivalued field. The Individual Boolean value defines whether the extruded parts of the mesh should stay together or not. If the value is unchecked, the extruded parts will form faces in between the gaps of the extruded faces. The Mesh output gives the extruded mesh, along with all the modifications. The two other Boolean values define the sides and tops of the extruded mesh. In Figure 2.7 you can see what is considered a top extruded face and what is considered a side extruded face.


[image: Figure 2.7: Tops and sides of the extruded mesh]Figure 2.7: Tops and sides of the extruded mesh

Now that we’ve explained the basic mesh nodes, let’s go over the basic points nodes that you will be using.




Understanding Points manipulation Nodes

Points are mainly used to distribute instances onto a mesh, but you can do so much more with them! Learning how to distribute points onto a mesh is a crucial step in learning about Geometry Nodes. So, without further ado, let’s get right into this section.


The Distribute Points on Faces node

This node (Figure 2.8) is used to randomly distribute points onto a mesh.


[image: Figure 2.8: The Distribute Points On Faces node]Figure 2.8: The Distribute Points On Faces node

It takes a base mesh as an input, such as a plane or Ico Sphere, but any geometry that contains faces works. It will randomly scatter points all over your inputted mesh with the distribution method of your choice. There are two point distribution methods – Random and Poisson Disk – as shown in the following figure:


[image: Figure 2.9: Different distribution methods]Figure 2.9: Different distribution methods

Let’s look at these methods in detail here:


	Random: This will scatter the objects randomly around a mesh with no regard for the distance between each point.

	The Density value defines how dense the point distribution is.

	The Seed value defines the randomization pattern in the algorithm.




	Poisson Disk: This will scatter the objects with a Poisson sampling method, which means that you’ll have finer control over the placement of the points.

	Distance Min controls the minimum distance each point should have from another point.

	Density Max controls the max density of the placement of the points.

	Density Factor controls the total density by a factor of 0 to 1 which can also be controlled via a multivalued field. 0 would mean no points, while 1 would mean all points the node can add.

	Seed value controls the random placement of the points by the use of a randomization algorithm. Different seeds will give different placements.






The node has a Points output, which is a geometry output that does not contain the base mesh. If you want the base mesh, you’ll have to add it back with a Join Geometry node. The node also has the Normal and Rotation vector outputs, which define the way that each point is facing.



The Mesh to Points node

This node (Figure 2.10) will convert vertices to points without any randomization.


[image: Figure 2.10: Mesh to Points]Figure 2.10: Mesh to Points

This node will place a point at the location of every vertex. This can also be useful for distributing points in the shape of a grid.Once again, we have the Selection Boolean value to select which parts of the mesh will be converted to points.The Position vector value defines the position of each point. This is useful for placing the points in a custom position, for example, on a line or if you want to individually manipulate coordinates of all points based on a mathematical calculation. The last input is the Radius value. This defines the radius of each point. This radius does not serve much of a purpose other than a Viewport visual.



The Instance on Points node

This (Figure 2.11) is one of the nodes you will be using the most in your Geometry Nodes projects.


[image: Figure 2.11: Instance on Points]Figure 2.11: Instance on Points

This node will project the inputted Instance onto defined points. It takes a Points input. These are generated using the nodes of the previous subheadings. The Selection Boolean value defines whether it gets affected by the node or not. The Instance value defines the instance that should be used. You can use any mesh as an instance if you use a Geometry to Instance node, this is because, by default, normal geometry isn’t an instance yet. The next input, the Pick Instance Boolean value, is a value that will only be useful with instanced collections. When not using collections, this value will not affect anything. Collections are basically groups of objects. This Pick Instance mode allows you to pick a Collection and choose (using the Instance Index value) what object out of the Collection you want. This is useful if you want to scatter different types of rocks for example.The Rotation and Scale values define the rotation and scale of each instance separately. These nodes make use of multivalued fields that can be connected to the Random Value node or Noise Textures, as examples.




Instance nodes

In the previous section, we talked about how to place and instance points. In this section, we will explain how to edit these instances and modify them accordingly.


Translating Instances

Instance nodes (Figure 2.12) are used to position your instanced objects.


[image: Figure 2.12: Translating Instances nodes]Figure 2.12: Translating Instances nodes

These nodes include the Translate Instances node, the Scale Instances node, and the Rotate Instances node. These three nodes are generally the same in terms of input and output node connections.The Instances value accepts the instanced objects. These can be used to individually translate objects along the multivalued vector value. The Selection Boolean input defines whether the instance should be influenced by the node. 0 means not influenced, 1 means influenced. The last input is the Local Space input. If this is checked, the local space will be used as a positioning system; otherwise, the world space will be used as the standard positioning system. On the Scale Instances node, there is an option called Center. This defines the center where the scaling happens. It’s a multivalued node, so this can also be influenced by, for example, a noise texture or a random value. The Rotate Instances node has an extra option called Pivot. Just like the Center option in the Rotate instances node, this defines the center of where the rotation will happen.



The Geometry to Instance node

This (Figure 2.13) is a very widely used node.


[image: Figure 2.13: The Geometry to Instance node]Figure 2.13: The Geometry to Instance node

The Geometry to Instance node will convert Geometry to Instances. What this means is that the inputted geometry will be converted to an instance object, so it can be used for operations such as the Instance on Points node. For example, if we want to instance a cube along a mesh, we will first have to convert that cube into an instance using this node. We will be exploring this node in-depth in further chapters.The only input socket on this is a multi-connection socket that accepts multiple geometry inputs and joins them as an instanced object. Each line going into the Geometry socket will be its own instance.



The Realize Instances node

This node (Figure 2.14) is used to convert Instances back to Geometry.


[image: Figure 2.14: The Realize Instances node]Figure 2.14: The Realize Instances node

The main problem that you might face if you apply the Geometry Nodes modifier is that instances might disappear from your mesh. This happens because instances are a mere illusion of mesh. They are not real geometry, but they appear as real geometry. To make them real geometry, we need to realize the instances.This node will solve that by converting, or realizing Instances back to a normal Geometry mesh.We can see three additional inputs to this Realize Instances node:


	Selection Boolean input: This will define what instances will be converted to geometry by the use of a boolean input.

	Realize All checkbox: The realize all option will realize all top-level instances along with their nested instances. Using this option will disable the Depth integer input

	Depth integer input: The Depth value will limit the nested instances from realizing. If you have a nested instancing network which is 4 levels deep, if you set the Depth value to 2, the first 2 levels will be realized.



For example, if you are making a tree, where you make a trunk and then instance branches on that tree, the branch also needs instanced smaller branches, which in turn needs leaves to be instanced on the smaller branch. This is a basic example of nested instancing and will be demonstrated in Chapter 9.Let’s now go over the Converter nodes; you’ll need these nodes if you want to experiment with different kinds of geometry, like volumes, curves and meshes. With this step comes a lot of problem-solving and creative thinking. We will be discussing Converter nodes last since these nodes will bind all the previous sections together.




Converter nodes

The following nodes are used to convert certain types of geometry to other types of geometry, such as mesh, Curves, instances, volumes, and points. Most of these nodes are just input-output nodes. So, I will only go over the special ones that need more explanation.


The Curve to Mesh node

This node will convert Curves to mesh. We also have the option to add a profile to the curve as shown in Figure 2.15.


[image: Figure 2.15: The Curve to Mesh node]Figure 2.15: The Curve to Mesh node

The Profile Curve value accepts a curve node connection such as, for example, a curve circle node. It can also be modified in thickness using a Set Curve Radius node. The Profile Curve value defines what shape your curve will have. If you just want it to be a tube, you can use a circle. If you want it to be a custom shape, you can use any curve you want to define the shape of your curve profile. The Fill Caps Boolean value defines whether the Caps should be filled in or not. The Caps are the ends of the curve profiles. The opposite node, the Mesh to Curve node converts the mesh to a curve by disregarding the faces. This node can be seen in Figure 2.16:


[image: Figure 2.16: The Curve to Mesh node]Figure 2.16: The Curve to Mesh node

Similarly to previous nodes we’ve seen, for example the Set Shade Smooth node, this node has a mesh input, which will be our base mesh that we want to convert and a Selection Boolean input to define what parts of the mesh should be converted to curves.The node outputs the inputted mesh as a Curve format.



The Mesh to Volume node

This is the Mesh to Volume node, and is very handy to be creative with defining shapes via mathematics, as we’ll learn in the coming chapters.


[image: Figure 2.17: The Mesh to Volume node]Figure 2.17: The Mesh to Volume node

This node allows you to convert your mesh to a volume. One use case example of this node is that, if we take a mesh with messy geometry, and we make a volume out of it, and we take that volume and convert it back into a mesh using the Volume to Mesh node, we can get a clean topology for our objects, much like the Remesh function.The Mesh to Volume node has six inputs. For starters, it has the standard Mesh input that most mesh nodes have. Below the Mesh input, you will see the Density input. This value will define the density of the volume. A higher value means more densely packed volumes.Voxel Amount defines the resolution of your volume. In other words, it defines the number of voxels your volume is allowed to contain. A Voxel is a volume element; it literally stands for volumetric pixel. Here, you can see a visual demonstration of how the voxel amount progresses:


[image: Figure 2.18: Voxel Amount demonstration]Figure 2.18: Voxel Amount demonstration

Finally, Interior Band Width defines the size of the inner voxels of the volume. Turning this value up will create a smoother gradient to the inside of your volume. The lower this value is set, the thicker the sides of your volume are. Most of the time you won’t be using this setting.



The Volume to Mesh node

Last but not least of the nodes in our list is the Volume to Mesh node.


[image: Figure 2.19: The Volume to Mesh node]Figure 2.19: The Volume to Mesh node

This node, as the node name suggests, will convert Volumes to Mesh data. There are three options for defining the resolution of this converter node:


	Grid: This allows you to divide your volume into a grid of vertices. This option comes with the Threshold and Adaptivity values.

	Amount: This allows you to control the amount of voxels you will take into consideration when converting this mesh. This option comes with the Voxel Amount, Threshold, and Adaptivity values.

	Size: This allows you to control the size of each voxel. This might be a better suit for your needs but will be less simple to control on a large-scale mesh.



We will be covering Amount since it gives the most control over what you’re trying to achieve. You might find another option handier for your projects, so be sure to experiment with the different options.This node contains the standard Geometry input, which accepts volumes, the Voxel Amount value, and the Threshold and Adaptivity values. We have already covered the Voxel Amount value in Figure 2.17. It’s the same concept but in reverse. So, instead of converting mesh to a volume, we’re now converting volumes to mesh. The Threshold value defines at what density the volume should be turned into a mesh. For example, if we want every voxel to be turned into a mesh, we can use a really low threshold such as 0.001. But you might want to fine-tune your threshold to get the result you like.Adaptivity will decimate your final mesh into a less performance-hungry mesh. You can experiment with this value if you’re having performance issues.The Mesh to Volume and Volume to Mesh nodes we covered can also be combined to make an excellent Remesh node with a lot of control. A Remesh function inside Blender is basically a way to clean up your topology simply and efficiently. It rewires your topology by using an algorithm. We will cover this in the advanced parts of this book.With the Volume to Mesh node, we have come to the end of the chapter.




Summary

In this chapter, we covered what nodes you’ll be using most frequently, along with the reason why these nodes are useful. We went over the inputs and outputs of the nodes and explained each parameter in depth.Knowing about these parameters will help you better understand future nodes and develop a sense of how the Geometry Nodes system works.Now that you have a clear understanding of all the basic nodes you will be using, let’s move on to the next chapter!In the next chapter, we will go over the add-ons that might be useful when working in the Geometry Nodes editor.






3 Must-Have add-ons for Building Node Trees


Join our community on Discord

https://packt.link/weEskIn the previous chapter, you learned what the basic nodes do. In this chapter, let’s have a look at the different add-ons you can use with the Geometry Node editor. These add-ons have some cool features, and they can help speed up your workflow greatly. We will also show you how to use these add-ons and where you can find them. In this chapter, we will cover the following topics:


	Exercise – how to enable and install add-ons in Blender

	Understanding the Node Wrangler

	Exploring the GeometryNodesAttributeViewer



We will begin this chapter by learning about the Node Wrangler add-on. This is a tool that you will use a lot in your Geometry Nodes workflow.



Exercise – how to enable and install add-ons in Blender

If you have watched any Blender tutorials on YouTube or other tutorial platforms, you’ll have noticed that the Node Wrangler and GeometryNodesAttributeViewer add-ons are widely used because they offer a wide variety of handy tools that could be useful in any node editor inside Blender. In fact, every tutorial expects you to have at least Node Wrangler installed, so we really recommend installing them before continuing with this chapter and the rest of this book. Let’s first go over how to install and enable these add-ons!We will first need to enable these add-ons for them to work since they’re not enabled by default.


Enabling add-ons

Let’s quickly cover how to enable the coming add-ons.


	Let’s start by heading over to the Blender Preferences dialog inside Blender, which can be found in the Edit menu on top of your main Blender page. Once you are in the Preferences, click on the Add-ons tab.


[image: Figure 3.1: Blender Preferences Dialog]Figure 3.1: Blender Preferences Dialog


	When you are in the Add-ons tab, search for the first add-on we will be covering, called the Node Wrangler Add-On.


[image: Figure 3.2: Node Wrangler add-on entry]Figure 3.2: Node Wrangler add-on entry


	You can enable this add-on by clicking the square on the left-hand side of the title.



This will add the Node Wrangler add-on to your Blender Preferences and will stay there even if you open another project. To disable the add-on, just uncheck the check mark.Here, we’ve seen how you can install the Node Wrangler yourself. This progress is the same for any other official Blender add-on. However, when adding unofficial add-ons, the process is a little different.



Installing add-ons

In the instructions that follow, we’ll show you how to install unofficial add-ons for Blender made by third parties! Let’s get into it.


	When installing unofficial add-ons, head to the top-right corner of the Add-ons tab and press the downfacing arrow.

	In this menu, you’ll find the option called Install from Disk…


[image: Figure 3.3: Add-ons settings menu]Figure 3.3: Add-ons settings menu


	Once you press this button, Blender will ask you for the file of the downloaded add-on, which is usually in a .zip format.

	Once you’re done selecting your add-on, go ahead and press the button labeled Install from Disk, which will automatically activate the add-on.




[image: Figure 3.4: Install from Disk button for confirmation]Figure 3.4: Install from Disk button for confirmation

Now that it’s clear how to install add-ons and where these add-ons can be found, let’s move on to covering what the power of add-ons can do! The first add-on we’ll be covering is called the Node Wrangler.




Understanding the Node Wrangler add-on

The Node Wrangler add-on was developed by Bartek Skorupa, Greg Zaal, Sebastian Koenig, Christian Brinkmann, and Florian Meyer. It provides tons of great tools and features to speed up your workflow in any node editor inside Blender. In this section, we will go over how to use the add-on, along with shortcuts this add-on makes use of.This is a built-in add-on inside Blender and does not need additional installation to get it working.The Node Wrangler add-on is mainly designed to be used with shortcuts. So, we will be explaining the usage of some of the most useful shortcuts that can be applied using this add-on.It is notable to mention that this add-on isn’t only usable in the Geometry Node editor but is made for use in every node editor in Blender. This includes the Compositor and the Material editor.


Using the add-on

Let’s start by explaining how to easily connect nodes. Usually, you’ll have to connect node sockets by dragging one dot to another dot. With this trick, you’ll be able to drag one node to another to automatically connect them.Many users struggle with efficiently connecting nodes, but this add-on makes that really easy.By using the Alt + right-click shortcut while dragging from one node to another, the Node Wrangler add-on will automatically create an appropriate link between both nodes. It will check what the most plausible way to connect the two nodes is. By using the Alt + X shortcut, Node Wrangler will delete any unused or unconnected nodes from your node tree. This is very useful when you have finished a big node tree and you want to clean it up. The Shift + C shortcut allows you to copy the settings from one node to another. Keep in mind that these nodes have to be of the same type. This might be useful if you have a node that you want to append inside of a node tree, but you don’t want to disconnect it.By selecting the receiver node first, and then the main node, the main node will transfer its attributes to the receiver node. In this menu, you also have the option to copy and transfer various types of labels from the selected nodes.If you want to clear a label from a node, you can always use the Alt + L shortcut.Along with clearing labels, of course, we also have the option to modify our node labels.To modify a label using the Node Wrangler add-on, you can press the Shift + Alt + L shortcut. This will allow you to quickly rename any node or node group.Using the / (slash) shortcut, you can conveniently add reroutes to your node tree.“What’s a reroute?” I hear you ask.On Figure 3.5, you see a picture of a reroute connection.


[image: Figure 3.5: Reroute connection]Figure 3.5: Reroute connection

A Reroute is a type of node connection that is not dependent on a node. It is used to organize your node tree, as well as to easily connect large amounts of nodes to other nodes. The color of the reroute depends on the color of the node connection that it is inputted into. As said before, a reroute acts much like a normal node connection. This reroute can also be moved around by pressing G on your keyboard.We will get into organizing your node tree in a further chapter.When you press the / key, you’ll see this menu appear.


[image: Figure 3.6: Add Reroutes menu]Figure 3.6: Add Reroutes menu

Let’s break down this menu here:


	To All Outputs means that the Node Wrangler add-on will add reroutes to all the outputs of the nodes.

	To Loose Outputs means it’s only going to add reroutes to the node outputs that aren’t occupied by a node connection.

	To Linked Outputs means it’s only going to add reroutes to the node outputs that are occupied by a node connection. Additionally, you can also add reroutes by pressing Shift + right-click and dragging over a node connection line.



By pressing O, you can connect the selected node to the end node, the Group output node.This is useful to see the effects of the selected node. Let’s say you want to see what a certain node is outputting. Pressing O on this node will connect it to the Group output, allowing you to quickly see the effects of the selected node. You can reverse this connection by pressing Ctrl + Z, like in any program.


The quick access panel

Let’s also cover the quick access panel of Node Wrangler. This might be more useful to users that aren’t big fans of using many shortcuts in Blender. The panel can be accessed from the right hand-side of the Geometry Node editor or by pressing Shift + W.


[image: Figure 3.7: Node Wrangler menu]Figure 3.7: Node Wrangler menu

Let’s break down this panel here:


	At the top of this menu, we see the Merge Selected Nodes option, which allows you to merge any type of data, such as geometry or math data, in a convenient manner. We have four main options to merge geometry data:

	Join Geometry

	Intersect

	Union

	Difference






These options will add the appropriate nodes to make the selection possible .


	We also have the option called Use Math nodes, which allows us to conveniently add Math nodes in Blender.

	The Detach Outputs button does exactly as the name suggests; it detaches the outputs of the current node that you have selected. Here, we also have the option to swap links, which will swap the input fields of a node which has more than two input fields connected to other nodes.

	The next button, Frame Selected, will group the selected nodes in a frame; this is convenient for when you want to clean up your node tree or make your node tree easier to understand for other people. You can also use this to add comments to your node trees.

	Below that, we have the Align Nodes button. This is useful for aligning all nodes on a straight line. This can help you with the process of cleaning up your node tree.






Shortcuts

Let’s go over the shortcuts we’ve learned in this chapter so far.




	
	Auto-connect nodes



	
	Delete unused nodes



	
	Switch node types



	
	Copy node attributes



	
	Clear a node label



	
	Modify a node label



	
	Add reroutes



	
	Drag and add a reroute



	
	Connect a node to Group Output



	
	Open the quick access panel





 To the PD: Please change the above table into an image. 
Keep in mind that this shortcut list is based on the Blender default shortcut settings.Let’s now take a look at another useful add-on for inspecting the data of geometry nodes live in your viewport.




The GeometryNodesAttributeViewer add-on

If we look back at Chapter 1, we explained what the different attributes are, for example, the Float attribute, the Vector attribute, the String attribute and many more.A problem a lot of Geometry Nodes users run into is that they can’t visualize the multivalued attributes well in their projects, that’s what the GeometryNodesAttributeViewer add-on is made for. This add-on is written by Griperis (Zdeněk Doležal) and helps the user to visualize data from the Geometry Node editor right into the viewport. This add-on is very handy when debugging your node tree to see what the values of certain locations are.Since this add-on is not an official add-on, you’ll have to first download it from the GitHub repository before being able to use it. The add-on can be downloaded from the link here: https://github.com/Griperis/GeometryNodesAttributeViewer


Where to find the functions of this add-on?

Let’s start by heading to our Geometry Node editor and adding a new node tree to our default cube.To add new nodes into your node tree, you execute the shortcut Shift + A.Once you executed this, you’ll see the option called View, which is where the GeometryNodesAttributeViewer add-on resides.


[image: Figure 3.8: Add nodes menu with the View option highlighted]Figure 3.8: Add nodes menu with the View option highlighted

Let’s uncover what’s in this add-on does by hovering your mouse over the View button.Once you do that, you’ll see the following options appear on your screen:


[image: Figure 3.9: View nodes menu]Figure 3.9: View nodes menu

Let’s start by covering what each of these options do!This is what you’ll see when you add any of the presented nodes:


[image: Figure 3.10: GeometryNodesAttributeViewer nodes]Figure 3.10: GeometryNodesAttributeViewer nodes

At first sight, this might seem very overwhelming, but let’s break each of the options down.


	On each of the nodes, we see the option to input a base Geometry and a Selection input. From previous chapters you know that this Selection input is used to define what points are influenced based on a Boolean attribute type.

	If we look further down each node, we see that each node has a Domain option. This is to define where we will measure our attributes on. The value goes as follows:

	0: The values will be measured and placed on each vertex

	1: The values will be measured and placed on each edge

	2: The values will be measured and placed on each face

	3: The values will be measured and placed on each face corner

	4: The values will be measured and placed on each instance, we will go further into instances in further chapters.






5: The values will be measured and placed on each spline. A spline is a part of a Curve, which we will also cover in further chapters.


	The option Base present on some of the nodes is used to calculate numbers used in different number systems, which you should generally not touch.

	The Scale option present on all nodes will scale the values of information that the nodes provide.

	The Color value will change the color of the debug information for each of the nodes.

	At the bottom of all of the nodes we see two Boolean Inputs, which are explained here:

	Viewport Only: This option will make sure the annotations or debug information won’t show up in renders.

	Show Original Geometry : This option will hide or show the original Geometry plugged into the begin of the node. This is useful for if you want to further alter the object without altering the debug text.




	Lastly, the most important input of this node, the Attribute input. This will be the input that will be receiving all the data that needs to be shown in the viewport. Depending on what node you use, the datatype will vary.



You might be asking, what node do I use for what scenario? That all depends on what datatype or attribute type you’re trying to visualize. The GeometryNodesAttributeViewer add-on can visualize 4 types of attributes.


	Float values

	Vector Values

	Vectors

	Colors



To answer what the difference between Vector Values and Vectors is, let’s quickly take a look at what a Vector is in math.



What is a vector?

A vector can be seen as a coordinate that defines a direction, specifically, an X, Y and Z coordinate. Vectors can be used in Blender for multiple things, such as defining a Position, a Direction/Rotation or a Scale.For simplicity we’re going to explain it in a 2D version, which only includes 2 values. Keep in mind that in Blender, Vectors make up 3 values, because we use 3D.By looking at the graphic below, we define a direction by sending a vector to coordinate (2,2)


[image: Figure 3.11: Visualization of a vector in math]Figure 3.11: Visualization of a vector in math

To answer the original question, the View Vector node will display the direction this arrow is pointing in, while the View Vector Values node will display the three X,Y and Z values respectively. These colors are usually defined by Red (X) Green (Y) and Blue (Z)On the image shown next, you visually see the difference and use case of all the nodes we covered in this add-on:


[image: Figure 3.12: Implementations of GeometryNodesAttributeViewer]Figure 3.12: Implementations of GeometryNodesAttributeViewer

In Figure 3.12 you can clearly see the different types of data visualization possible with the GeometryNodesAttributeViewer add-on, along with that, the Input we used is also mentioned. This add-on is excellent for debugging or finding out how an object exactly forms itself.And with that, we have come to the end of this chapter!




Summary

In this chapter, you learned how to use the Node Wrangler add-on with both shortcuts and the quick access panel. This chapter also showed you how to use the GeometryNodesAttributeViewer add-on. It also showed how to access as well as install these add-ons.These add-ons will help you greatly by offering tools that are useful in the Geometry Node editor, as well as in other node editors such as the Material editor and the Compositor.In the next chapter, we’ll go over the primitive shape nodes. You will learn how to add these nodes to the node editor, what all the nodes do, and their options.






4Making Use of Node Primitives


Join our community on Discord

https://packt.link/weEskIn the previous chapter, we introduced you to the various add-ons we can use along with the Node editor. In this chapter, we will introduce you to the Node Primitives of the Blender Geometry Node editor, why you should use them, where you can find them, the different kinds of nodes, and lastly, we’ll end the chapter with an exercise on Node Primitives.In this chapter, we will be covering the following topics:


	Introduction to Node Primitives

	Exploring Mesh Node Primitives

	Understanding Curve Node Primitives

	Exercise – Your first Geometry Nodes project





Introduction to Node Primitives

Node primitives allow you to place primitive shapes into your scenes by using various nodes. But firstly, what are primitives? Primitives are shapes that are relatively simple in terms of geometry or can be calculated using a mathematical equation. In Blender, these objects include a grid, a cube, a cylinder, and two different types of spheres.Curves also have various primitives, these include a line, a circle, a star, a spiral, and a Bezier curve.Node primitives are really easy to use. Each node primitive will likely convert a bunch of parameters into a single mesh/curve object that will be outputted as a geometry output node socket.But why use node primitives? They are really useful because we can change the properties of these shapes while working in the Node editor. It’s a matter of changing a value or slider to change the shape of the primitive.


Where can you find node primitives?

Node primitives can be found in the Add menu in the Geometry Node editor. The Add menu can be accessed by clicking on Add at the top of your Geometry Nodes window or by pressing Shift + A:


[image: Figure 4.1: The Add menu]Figure 4.1: The Add menu

This menu will have all the nodes of the Geometry Node editor, including the ones we’ll cover, the curve primitives, and the Mesh primitives, which are highlighted in Figure 4.1. Hovering with your mouse over these entries will expand the chosen menu.We will begin with the Mesh Node Primitives.




Exploring Mesh Node Primitives

Mesh Node Primitives will generate a primitive shape of your choice in the datatype of a mesh output. These include Cone, Cube, Cylinder, Grid, Ico Sphere, Mesh Circle, Mesh Line, and UV Sphere. These nodes will basically generate mesh inside your Geometry Node editor.


Where can you find mesh node primitives?

Mesh nodes can be found in the Add menu. As stated before, the Add menu can be found by pressing Shift + A. You will find the Mesh entry in the dropdown that appears (Figure 4.1). When hovering your mouse over the Primitives menu, you will see the menu shown in Figure 4.2:


[image: Figure 4.2: Mesh Primitives menu]Figure 4.2: Mesh Primitives menu

This menu will show all the mesh primitive nodes that we will be explaining in this section. Let’s get into it!



Cube Node Primitive

The Cube Node Primitive (Figure 4.3) is one of the most basic node primitives that you will be using. This allows you to place cubes in your Geometry Nodes projects:


[image: Figure 4.3: Cube Node Primitive]Figure 4.3: Cube Node Primitive

As you can see in Figure 4.3, we have a vector input that defines the X, Y, and Z dimensions of the cube. Using this node, we can also control the number of vertices that this cube will contain on each axis. This is comparable to adding loop cuts to a cube in Edit Mode. The node outputs the generated cube mesh using a geometry output.The node outputs the Mesh of the Cube we generated in this node primitive along with the UV Map of the cube in a Vector format.



Grid Node Primitive

The Grid Node Primitive (Figure 4.4) allows you to create a mesh that is essentially a plane. This will be useful when you want to start your Geometry Nodes project with a plane shape (also referred to as a grid):


[image: Figure 4.4: Grid Node Primitive]Figure 4.4: Grid Node Primitive

Much like the Cube Node Primitive (Figure 4.3), we can control the X and Y dimensions of this plane by using the value input sockets or by changing the values directly. We also have the option to change the X and Y vertex count again. This will add subdivisions on each of these axes, much like with the Cube Node Primitive.Just like the last node, the outputs of this node are Mesh and UV Map, which we can use to manipulate the object further.



UV Sphere Node Primitive

The UV Sphere Node Primitive (Figure 4.5) will allow you to create a sphere while having control over the segments, rings, and radius of the outputted sphere. This is useful when you want to control the vertical and horizontal resolution of your sphere:


[image: Figure 4.5: UV Sphere Node Primitive]Figure 4.5: UV Sphere Node Primitive

Let’s quickly go over the options that this node presents:


	Radius is half the size of the UV Sphere mentioned in meters.

	Segments are the vertical rings that the sphere will have; in other words, the vertical resolution of your sphere.

	Rings are the horizontal rings that the sphere will have – the horizontal resolution of your sphere.



You might be wondering: “What’s the difference between Rings and Segments?”In the Figure 4.6 you can perfectly see what rings and segments do. Segments define the horizontal resolution and rings define the vertical resolution.


[image: Figure 4.6: Segments and Rings demonstration]Figure 4.6: Segments and Rings demonstration

Now that you know how to use the UV Sphere node, let’s move on to learning about a different kind of sphere.



Ico Sphere Node Primitive

Like UV Sphere, Ico Sphere (Figure 4.7) is also a sphere. The difference is that Ico Sphere is made up of triangular faces and they’re not connected with segments and rings, but instead, they form an even topology.


[image: Figure 4.7: Ico Sphere Node Primitive]Figure 4.7: Ico Sphere Node Primitive

While the UV Sphere and the Ico Sphere might both be spheres, there is a crucial difference in the topology of the two options. In the following figure, you can see the difference in the topology:


[image: Figure 4.8: Difference between UV Sphere and Ico Sphere]Figure 4.8: Difference between UV Sphere and Ico Sphere

The UV Sphere consists of segments that connect to a single vertex at the top and bottom, along with rings that stretch around the sphere.The Ico Sphere has a better-defined, more even topology. A great topology is crucial if we want to modify any kind of mesh, like when you want to displace your mesh, which we will explain in Chapter 9.As shown in Figure 4.7, the Ico Sphere Node Primitive consists of a Radius value and a Subdivisions value; the Subdivisions value simply defines the resolution of the Ico Sphere, while Radius controls the scale of the sphere by increasing its radius.



Mesh Line Node Primitive

The Mesh Line Node Primitive (Figure 4.9) defines a simple line mesh:


[image: Figure 4.9: Mesh Line Node Primitive]Figure 4.9: Mesh Line Node Primitive

There are two different options for this node, Offset and End Points, as seen in Figure 4.10:


[image: Figure 4.10: Different Mesh Line modes]Figure 4.10: Different Mesh Line modes

In the Offset mode of this node, we can control the Start Location and Offset values. Both of these can be controlled via a vector node socket. The Count defines how much each offset should be repeated with a new mesh line iteration. The Count also defines how many vertices are contained in the mesh line.The End Points mode of this node will add points to your line by first defining the start point and the end point, and then allowing you to add points in between these two vector locations. Using the Count option, you will get precise control of how many vertices there will be in your mesh line. Using the Resolution option, you will be able to control how many vertices there will be in the mesh based on the allowed distance per vertex. For example, a resolution of 0.7 meters will place a vertex every 0.7 meters apart from each other.



Cone and Cylinder Node Primitives

The Cone and Cylinder Node Primitives (Figure 4.11) are two of the more advanced node primitives in the Geometry Node system:


[image: Figure 4.11: Cylinder and Cone Node Primitives]Figure 4.11: Cylinder and Cone Node Primitives

To make learning this node easier, let’s break it down by its inputs and outputs.


	The Vertices integer value defines how many vertices each ring will contain (the rings are the horizontal lines of the object).

	The Side Segment integer value allows you to control the number of these horizontal lines or rings.

	The Fill Segments integer value allows you to control the inner rings of the top and bottom face. These rings will stay and loop around on only the bottom and top faces.

	The two radius values (one radius value in the case of the Cylinder node) define the radius on the top and bottom of the object. For example, to make a cone correctly, you have to set Radius Top to 0.

	The last value, the Depth value, defines the height of your cylinder or cone.



Both nodes share the same output sockets; one output socket is used to output your object geometry, and the other three Boolean values define the top, bottom, and sides of your mesh. These node outputs can be used on Boolean node inputs for cases like mesh selection and other Boolean node connection use cases.When we click on the Fill Type menu, we are presented with three fill type options, as you can see in the following figure:


[image: Figure 4.12: Fill Type menu]Figure 4.12: Fill Type menu

Let’s understand these options here:


	None means that it will not fill in the top and bottom faces; the top will be open.

	N-Gon means that the center face at the top will be joined into one N-Gon face.

	Triangles means that the center faces at the top will be joined into a star shape or multiple triangles to prevent N-Gons since we do not want messy topology!



In Figure 4.13, you can see a visual representation of what the different Fill Types mean:


[image: Figure 4.13: Different Fill Types]Figure 4.13: Different Fill Types

Now that you have a solid understanding of the different Mesh Node Primitives, let’s take a closer look at the Curve Node Primitives!




Understanding Curve Node Primitives

Curve Node Primitives are the basic Curve shapes that you can use in the Geometry Node editor. These include Arc, Bezier Segment, Curve Circle, Curve Line, Curve Spiral, and more.


Where can you find Curve Node Primitives?

Just like the Mesh Node Primitives, the Curve Node Primitives can be found in the Add menu (Figure 4.1), under the Curve entry, Primitives. Once you hover your mouse over this entry, the menu shown in Figure 4.14 should pop up:


[image: Figure 4.14: Curve Primitives menu]Figure 4.14: Curve Primitives menu

Each entry in this menu is a Curve Node Primitive. We will explain the commonly used ones in this heading, so without further ado, let’s get right into the Curve Node Primitives.



Curve Line Node Primitive

Using the Curve Line node, we can define a straight path. This will be useful when you want to align objects along a straight line or when you want to create a pole. This can be done by giving the Curve thickness:


[image: Figure 4.15: Curve Line Node Primitive]Figure 4.15: Curve Line Node Primitive

There are two different modes in which we can use this node. These two modes are called Points and Direction. In the following diagram, you can see the values each mode presents:


[image: Figure 4.16:: Different modes]Figure 4.16:: Different modes

Using the Points mode, we can simply define the Start vector location and the End vector location of the line. If you want to make the line longer, you must modify the End location and move it further away from the Start location vector.Using the other mode, the Direction mode, we can define the Start location and give a direction that it should follow, depending on the use case; for example, if you want to define a direction, this might be a better choice. Along with the Direction vector, we also get the option to define the length of the line. The output of this node will give the finished Curve following the parameters you have entered.



Curve Circle Node Primitive

The Curve Circle node will add a circle to your Geometry Node editor by making use of Curves. This can be useful to make shapes aligned in circles or to make a donut by giving the Curve Circle shape thickness by using a Curve to Mesh node. Keep in mind that the Curve to Mesh node will also require a Profile Curve input. This will be explained in the coming chapters.


[image: Figure 4.17: Curve Circle Node Primitive]Figure 4.17: Curve Circle Node Primitive

Just like the Curve Line node, we are presented with two different modes for defining the shape of this circle: Points and Radius.


[image: Figure 4.18: Different modes]Figure 4.18: Different modes

The Points mode is used to create a circle based on the placement of three X, Y, and Z points. These points can also be controlled by a vector node input. The Resolution integer value defines how many vertices this curve circle should contain.When we switch over to the Radius mode, we are presented with a much simpler interface, and this is the option you will be using the most. In this mode, we can only change the radius and resolution of the circle. Just like in the Points mode, the resolution defines how many vertices the curve circle should contain.



Bezier Segment Node Primitive

The next primitive is Bezier Segment. This will define a Bezier curve using four vector values – Start, Start Handle, End Handle, and End:


[image: Figure 4.19: Bezier Segment Node Primitive]Figure 4.19: Bezier Segment Node Primitive

Once again, this node has been equipped with two different modes to define a primitive curve. If you have ever worked with Blender curves before, you will know what handles are.For those who have not worked with handles in Blender, they essentially define the tangent that your Curve will follow by defining two extra locations:


Figure 4.20: Tangents in Blender
The red lines you see in this diagram are handles. Let’s start explaining the node now.The Start vector value defines the beginning position of your Bezier segment. The Start Handle vector defines where your handle (the red line) should begin. Logically, the End Handle vector defines where the handle should end.Finally, the End value defines the end position of your Curve.The differences between the modes are that the Position mode makes sure that the Start and End handles are in a fixed position.On the other hand, if we use the Offset option, the Start and End handles will be defined by offsetting them from the start and end of the Curve.



Star Node Primitive

This node will define the shape of a star with various levels of control:


[image: Figure 4.21: Star Node Primitive]Figure 4.21: Star Node Primitive

Here are the various input values for it:


	Points will control the number of points your star contains. This will also define how many vertices your Curve will contain. If we double the points value, you get the vertex count of the star curve.

	Inner Radius defines how thin your star is, you can imagine this as an inner circle inside of your star.

	The Outer Radius defines how long the spikes of your star should be.

	The Twist value will twist the inner part of your star, creating a twisting effect:




[image: Figure 4.22: Star twisting]Figure 4.22: Star twisting

Finally, let’s move onto the Spiral Node Primitive.



Spiral Node Primitive

The Spiral Node Primitive will define a spiral shape with a Curve:


[image: Figure 4.23: Spiral Node Primitive]Figure 4.23: Spiral Node Primitive

This node can be useful when you want to align objects in a spiral shape. So, without further ado, let us get right into teaching you all about this node:


	The Resolution integer value defines the number of vertices the spiral curve should contain. The amount reflects the number of vertices each layer should have.

	The Rotations value will rotate the spiral X number of times before it reaches the Height value.

	Start Radius defines the radius that the spiral will follow at the beginning of the spiral.

	End Radius logically defines the radius that the spiral will follow when it nears the end.

	Height defines the height of the spiral; as stated before, the rotations will define the max rotations fitted in the given height.

	The Reverse Boolean value defines whether the Curve should be mirrored or not.



To wrap things up, we will teach you how to combine two primitives together using a Join Geometry node. This will be your first Geometry Nodes project.




Exercise – Your first Geometry Nodes project

Let’s start by creating your first simple Geometry Nodes project; we will be combining two Node Primitives.


	Let us first start by thinking about what nodes we will need. If we want to combine a plane and a cube together, we will need three nodes:

	Cube

	Grid

	Join Geometry: We will need Join Geometry to combine the two objects.




	Let us add a Geometry Nodes workspace to the default cube (or any other object; we won’t be using the mesh itself), and let’s open the Geometry Node editor:


[image: Figure 4.24: Geometry Node editor]Figure 4.24: Geometry Node editor


	We will not need the Group Input node since we will just use primitives, so you can go ahead and delete the Group Input node.

	Let us start by adding the Cube node to our Geometry Node editor. Start by pressing Add at the top of your Geometry Nodes Workspace and hovering your mouse over the Mesh tab, and then hover over the Primitives tab.

	After that, click on Cube.This will add the Cube node to your Geometry Node editor.

	Let us repeat this step for Grid. After that, your Geometry Node editor should look something like this:




[image: Figure 4.25: Primitives]Figure 4.25: Primitives

You will not see anything appear in the Viewport; this is normal and is because Group Output is still empty.


	Try connecting the Mesh output of Grid to Group Output. Once doing so, you will see that the grid (plane) will appear in the Viewport.

	We cannot directly combine the cube and the grid; to combine them, we will need a Join Geometry node. This will allow us to join two geometry outputs together. Let us disconnect the Grid node and add the Join Geometry node, this node can be found when pressing Add, Geometry, Join Geometry, as seen in Figure 4.26:




[image: Figure 4.26: add a Join Geometry node]Figure 4.26: add a Join Geometry node

This is how your Geometry Node editor should look right now.


[image: Figure 4.27: Join Geometry Node]Figure 4.27: Join Geometry Node


	Now it is time to connect these nodes. Let us start by connecting the cube output to the Join Geometry Input socket. This can be done by left-clicking the Mesh output of the cube and sliding it to the Geometry Input of the Join Geometry node.

	Since the Join Geometry node contains a multi-connection node socket, we can connect multiple node connections to the same socket. Let us now connect the Grid node to the socket as well. Your node tree should now look something like this:


[image: Figure 4.28: Connect the primitives to the Join Geometry node]Figure 4.28: Connect the primitives to the Join Geometry node


	All that is left to do now is to connect the output of the Join Geometry node to the Group Output node, this will ensure we’ll be able to visualize the result in the viewport:


[image: Figure 4.29 Connect Join Geometry node to Group Output]Figure 4.29 Connect Join Geometry node to Group Output


	Looking at the viewport, we can see that only the cube appears to be visible; in reality, the grid (plane) is covered up by the cube since they are the exact same size. Let us fix that by increasing Size X and Size Y of the grid to 2 on each axis:




[image: Figure 4.30: Increase the size of the Grid]Figure 4.30: Increase the size of the Grid

And that is it! Your first Geometry Nodes project!This brings us to the end of this chapter. We’ve successfully combined two Node Primitives together.



Summary

In this chapter, you’ve learned how to use the various Mesh Node Primitive and the various Curve Node Primitives. We’ve also shown you how to combine two primitive objects together using the Join Geometry node.Now that you know about the node primitives, you can move on to the next chapter. In the next chapter, you will learn how to distribute points onto a plane to start instancing objects or primitives onto a mesh.
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